
ArtRage 2.5 Quick-Start Guide.
Introduction. 

This file contains a quick 
start tutorial that shows you 
around some of the main 
features in ArtRage 2.5. It 
requires the full version of 
the product, as many of the 
features used are not avail-
able in the free version.

This quick start works best if 
you’re using a graphics tab-
let or Tablet PC that supports 
pressure. You can still use a 
mouse, just play with the 
Pressure Dial if you find your 
strokes look too harsh or 
light.

If you want more tips and 
tricks on using ArtRage, visit 
the ArtRage website online 
at www.artrage.com and 
check out the forum!

Step 1: Our Painting. 

We’re going to use one of the tracing images that come with ArtRage 2 to produce a 
painting. Tracing images give you a handy reference for painting and if, like me, you’re 
not an experienced artist they  can give you a bit of a boost and make it easier to pro-
duce something that looks good.

First of all, open up  ArtRage. We want to use a tracing paper as a reference and the 
easiest way to get the canvas the right size for this is to create a new painting.
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In the File Menu, select ‘New Painting...’. This opens the New Painting panel. 

The panel you get looks pretty  complex, but don’t worry, 
we’ll start simply. Click the ‘Load Tracing Image’ button near 
the top. This opens a file open dialog. Locate the folder this 
Quick Start document was in and you should see a file 
called ‘blue moon rose.jpg’. Select this file as your Tracing 
Image.

Now, back in the New Painting dialog, click the ‘Use Tracing 
Image Size’ button near the top of the New File dialog, and 
your new painting will be set to the size of the tracing im-
age.

Just click the OK button now, and the new painting will be 
created.

Step 2: Getting Started. 

When the painting appears, it 
looks pretty  good. That’s be-
cause the Tracing Image has 
been projected on to the can-
vas for you so that you can use 
it as a reference. Take a look at 
the bottom right corner of the 
window. You’ll see the Color 
Picker has popped up a notice 
telling you that Trace Color is 
being used. That means that 
ArtRage is going to pick your 
colors for you as you paint, 
based on what’s in the Tracing 
Image where you’re painting.



If your painting is too large for the window, there are a 
number of things you can do. If ArtRage isn’t in full screen 
mode, click the little window icon on the menu bar.

That makes ArtRage fill the screen and gives you a bit 
more space.

Select the Zoom Tool, and click/drag on the canvas to change 
its size to fit the window. Find a size that fits and you’re good to 
go. If at any time you want to get it back to normal, just hit the D 
key and it will reset itself.

Here’s another handy tip: If you want all of the panels to slide out of the way, just hit the 
Tab  key. You can press it again to bring them back. As you paint, panels will vanish out 
of the way when your brush gets close to them.

Now that we’re set up, we can get right in to painting.

Step 3: Outlines. 

We want to put in some outlines as a guide, but thinking ahead here we don’t want them 
to be painted over by our paint strokes. ArtRage lets you add Layers to your painting. 
Think of Layers as transparent sheets that you can paint on and lay on top  of each 
other. So, we can make sure our outlines are safe from other painting by adding them to 
their own layer.

To add a layer, click the ‘Add Layer’ button at the bottom of the Layer panel.

When you click this, a second sheet of paper will ap-
pear on top of the one that’s in there currently. The new 
sheet will have light grey checkers in it, those are just 
there to let you know that the new sheet is transparent, 
they won’t appear in your painting.

The green outline now surrounds the new Layer, mean-
ing it is selected and any paint applied will be placed on 
it.



Select the Pencil tool from the Tool Picker at the bottom left of the 
window.

The pencil will appear grey  until you point at it and click it. When it 
lights up  like this, it has been selected and drawing on the canvas 
will use the pencil tool.

Because we’re outlining, we want to work 
with black. ArtRage is currently selecting 
colors for us based on the tracing image. 
To select Black we need to turn that feature 
off, so click the color picker where it says 
‘Click for Normal Color’ and you’ll be able 
to select your colors again.

Choose black by sliding the slider on the 
right of the color picker all the way down. 
that slider controls how ‘bright’ the colour 
is. At the bottom, you’ll always have black.

For outlining, we want to use a nice dark pencil. ArtRage 2 lets you 
change the properties of your tools, so we’re going to create a big, soft 
pencil like a 6B. In the Tool Controls panel on the left edge of the screen 
you’ll see the following controls.

Set Pressure to 50%, this is the standard value for pressure when you’re 
using a graphics tablet. If you’re using a mouse you might find you need 
to adjust this dial if the pencil strokes look wrong. Don’t worry, if you 
make a stroke that looks bad just select Undo from the Edit Menu.

Set the Softness of the pencil to 75%. Softer pencils make darker 
strokes, the lead breaks up more easily. We want these strokes to be 
pretty visible. Using the Size Control in the tool picker, set the size of the 
pencil to 30%, that makes it nice and big.



Now go to your painting and start to outline the petals of the big rose. Ignore the smaller 
rose buds, just focus on the big one. Sketch naturally, just treat it like a pencil and paper 
and you’ll get much better results. Don’t worry about not being precise (who said art had 
to be precise?), just draw outlines where you see them in the Tracing Image.

Tip: If you feel that ArtRage is running slowly, you might just be seeing the pencil stroke 
‘lag behind’ the cursor. Don’t worry, this isn’t a slowdown, it’s just the way ArtRage tracs 
what you’re doing with the tool to make things more realistic! When you raise the mouse 
button the stroke will catch up immediately. ArtRage works best if you just sketch natu-
rally.

You might find that the Tracing Image isn’t quite clear enough for you to see all the lines. 
We can solve this by making the Tracing Image more visible. From the Menu Bar, select 
the Tools Menu, then from the Tracing Options menu item select ‘Edit Tracing Image...’.

This brings up the Tracing Controls. Locate 
the Opacity dial and turn the value up to 75%. 
You’ll find that you can see the rose more 
easily  and although your pencil strokes look a 
bit paler, they’ll be just as strong as before 
when we remove the Tracing Image later. 
Press ‘Done’ and you can return to painting.

Finish off the outlining by  sketching 
around some of the big leaves be-
neath the rose, and the stalk that 
attaches to it.

As a quick test to see how it’s go-
ing to look without the tracing im-
age, press T, the tracing image 
vanishes and you can see the out-
lines on their own. Leave the trac-
ing image off for now, we’re going 
to do the next bit using our outlines 
as a guide. In the best tradition of 
art tutorials, here’s how it should 
sort of look about now.

It looks pretty  rough, but that’s fine, 
we’re just using these lines as a 
guide.



Step 4: Color Blocking. 

Outlines are okay, but we want some color (and some paint!). We’re going to block in 
the big color areas using the Paint Roller tool. There are a couple of things we need to 
do first though.

First of all, we need to select the bottom layer so that we 
can edit it.

The Layers Panel sits on the right hand edge of the 
screen. You should have two Layers in there now: The 
pencil sketch Layer and the flat Background layer that has 
your paper color.

Click the bottom-most Layer to select it. You can tell it’s 
selected when it has a green outline as indicated in the 
image to the left.

We’ve been sketching on pretty mundane paper so far, so 
let’s change our canvas to make it a bit more interesting. 
There’s an arrow next to the bottom layer you just clicked, 
click it to get the Layer Controls up.

This panel gives you access to all the basic properties of 
your Layer. Usually, you won’t need to worry  about any set-
tings in here except the name if you want to give the Layer 
a name, and perhaps the Opacity if you want to fade it out.

Beneath the three settings at the top  is a list of all the op-
tions for your current Layer.

Right now, we want to change the settings of the Paper the 
Layer is made out of. Select ‘Edit Paper Settings...’ from 
the bottom of the list. This will open up the Paper Settings 
Panel, which contains all the controls for the Paper we’re 
using.



We’re just going to use a preset paper type at the mo-
ment. The presets are located in the big block with all 
the little previews.

Find the ‘Cockled Paper’ preset.

If you don’t see it, you may need to press the Next but-
ton to see the next page of presets. Click once on the 
Cockled Paper preview then press the OK button.

Your canvas changes, because you’ve just told it that 
it’s made out of a different type of paper.

You can see the difference in the appearance of the 
paper by looking closely. The paper is now crumpled, 
and when you paint on it you’ll see that the paint be-
haves as if there was a rough sheet beneath it rather 
than the smooth paper we started with.

You can change the nature of the paper any time you 
like, just go and edit the Paper Settings.

We don’t want to paint on the canvas directly, so let’s add another new layer. Click the 
New Layer button again and a new empty layer appears above the one you just 
changed.

Right, on to the painting! Select the Paint Roller from the Tool Picker.

We want to use a fairly small roller, so make sure its size is set to 
28% in the Size Control on the Tool Picker. The settings in its Tool 
Controls Panel (Pressure, Thinners, and Loading) should all be set to 
50%.

Now click the Menu Button on the Color Picker. Select ‘Choose 
Colors From Tracing Image’ so that we don’t have to worry about 
what colors are being applied.



Start to apply the roller around the inside of the 
pencil lines. Don’t worry about going over them, 
they are on the Layer above so any paint you apply 
is actually going under them.

The goal here is to fill in the rose. Paint lightly so 
that the paint is applied thickly. The Paint Roller 
can actually squeeze paint off the canvas if you 
press really hard, so don’t set pressure too high or 
push too hard while painting.

Apply a bit more pressure here and there and you’ll 
see the texture of the paper coming through.

Work with lots of strokes, don’t be 
afraid to go over the edges, this is 
going to be a busy painting, and 
the more strokes you apply, the 
more different colors you’ll get in 
your rose. Try to fill in the big 
blocks that you outlined and rub 
back and forth a bit if you want to 
blend the colors as you go.

When you’re done with the rose, 
do the same for the leaves (but 
not the stalk you outlined, that’s 
too narrow). Eventually, you’ll 
have something that looks a bit 
like this.

Don’t worry  about the edges or 
even the shapes, you’re just creat-
ing the basic color for the rose.

Now let’s add some detail to the painting!



Step 5: Detail. 

Add a new layer using the New Layer button. You’ll see it appear in 
your Layers Palette. Now select the Paint Brush from the Tool Picker.

The Paint Brush applies oils to your canvas, and can be used for finer 
work than the Roller.

We want to do some detailed work so set the brush to 21% size using the Size Control 
in the Tool Picker. Make sure it’s set to 50% Pressure in the Tool Controls Panel, 50% 
Thinners (we don’t want it too thin), and se the Loading value to 25% because we don’t 
want to do huge paint strokes at this point. Make sure Insta-Dry is set to OFF, and Auto 
Clean is also set to OFF. Those last two settings are to make sure the paint feels nice 
and wet when we use it.

What we want to do now is add a bit of detail to the painting. 
We’re going to do this by using the oil brush to paint the edges of 
each of the areas we outlined. Again, don’t be shy with the paint, 
don’t paint too slowly, just get in there and apply strokes around 
the edge of the different areas. You’ll generally find that the color 
being applied (which is still being selected from the tracing image 
automatically) isn’t the color of the paint roller stroke below, that’s 
good because we want some variance.

In the preview above, I painted 
around the edge of a petal and 
ended up with quite strong lines. 
You can smear paint around when 
you’ve applied it, or after even, so 
if you find something looks a bit 
too obvious, just drag back and 
forth over the stroke a bit and it’ll 
blend. Because you’re painting on 
a Layer, it won’t blend with the 
roller color, we don’t want it to 
though so that’s okay.

When you’re done with the petals, 
do the same with the leaves then 
use the brush to sketch in the stalk 
we left before. You should end up 
with something a bit like this.



Step 6: Background. 

So now we have a rose on an empty page. Let’s add a background to it. To keep a feel-
ing of harmony, we will create a background using colors from the tracing image itself. 
To do this, we’re going to use colors that have been previously  sampled from the image 
and stored in the Color Samples panel.

To open the Color Samples panel, locate the Tools Menu at the 
top, click it and select ‘Show Color Samples Panel’. This causes 
the panel to appear. You can also press ‘S’ to show or hide the 
panel.

When the panel appears, there are no color samples in it, this is 
because it’s for storing colors we want to use in the current paint-
ing. But you can load a set of samples from disk by clicking the 
menu arrow at the top of the panel and selecting ‘Load Colors..’

Select ‘Load Colors...’ and a file picker should open inside the ArtRage ‘Colors’ folder. 
Inside there, you’ll see some files containing custom colors. We’ve already created one 
for the rose image, so load ‘Blue Moon Rose.col’. If you don’t see that file, just navigate 
to the folder this tutorial file was in and you’ll find a copy of the colors there to load.

When you load the colors, the panel fills up with small ‘pots’ that 
contain all the colors that were stored for this image.

If it doesn’t look like the image to the left, just click the button at 
the top  of the panel with the three small ‘pots’. These colors 
haven’t been given names so it’s easier just to view them without 
the name visible.

We’re going to use the greens at the top of the panel.

To make a background we’re going to lay down some thick streaks of 
paint and smear them. To lay down the paint we need to use the Paint 
Tube. Select the Paint Tube from the Tool Picker. 

Make sure the size is set to 100% in the Size Control in the Tool Picker.

Click the ‘Click For Normal Color’ message in the Color Picker so that ArtRage is no 
longer choosing your colors for you, and select the bottom Layer from the Layer Panel. 
The bottom layer has nothing on it currently.



We’re going to put some big stripes of thick paint down on the canvas, then blend them 
together. When you first do this, it’s going to look really strange because you’ll see the 
lumpiness of the stripes through the rest of your paint but don’t worry, we’re going to 
smooth it down. This is why Layers are useful, even if the paint we apply underneath is 
lumpy, we can still flatten it out without damaging the paint on the Layers above.

In the Color Samples panel, click the lightest of the shades 
of green at the top. Now draw a stroke with it, starting at the 
top of the canvas and dragging it all the way to the bottom. 
Do this toward the left hand side of the canvas.

Add two more strokes of that color in different areas on the 
canvas, always dragging from the top  to the bottom so that 
you have 3 vertical strokes spaced out over the canvas.

You don’t need to be accurate here (you’re probably fed up 
of hearing that by now!), as we’re going to smear the strokes 
around to flatten them out and blend their colors together. 
So just go wild with the paint!

Next, select another one of 
the green shades from the 
Color Swatches Pane and 
repeat the process to add 
another 3 strokes.

Finally, select a third shade 
and repeat.

You should end up  with 
something a bit like the im-
age to the left, with lumpy 
strokes of paint running ver-
tically down the canvas. The 
lumps show through, but 
we’re going to fix that now. 

This is the really fun bit! We need to smear all of those strokes of paint 
around to flatten them out and blend them together in to a smooth se-
ries of colors.

Select the Palette Knife from the Tool Picker and make sure it’s set to 
use 100% size in the Size Control, and set its pressure to 50% in the 
Tool Controls Pane.



To blend the lines of paint together we make long 
strokes left and right over the canvas with the pal-
ette knife. You’ll probably need to run the palette 
knife back and forth a few times in one area before 
you start sliding it down to the next.

Notice that the colors blend as you smear. If you 
start the knife stroke on a darker color, more of that 
will spread over the lighter ones.

Don’t worry if you don’t like the result the first time, you can just select Undo from the 
Edit menu (or press Ctrl/Cmd + Z) if you want the stroke to be undone, and you can try 
again.

Work your way  down the 
canvas blending the tube 
strokes together. If you 
stroke over them and can 
still see the ridges of the 
stroke, press a bit harder or 
go back over them, it doesn’t 
matter how many times you 
do this, just blend the color 
and flatten them out.

When you’re finished, you 
should end up with some-
thing a bit like this. The look 
will vary based on how you 
smeared the tube strokes.

Now here’s a tip: In my version of the file there were some places 
where the green background color was visible through the painted 
strokes of the rose.

We don’t want the painting to look as if we’ve painted it on to differ-
ent layers (that’s our little secret) so we’re going to remove that 
green.

Select the Eraser from the Tool Picker, make sure it’s set to 100% size and set 
the Softness value to 100% in the Tool Controls Pane. This gives us a large 
eraser with a nice, soft edge.



With the background Layer still selected, use the eraser 
to erase under the area of the rose. Because we’re still on 
the bottom Layer, you won’t erase the rose itself, just the 
paint underneath it.

Don’t erase too far out, you don’t want to delete any of 
the paint outside the body of the rose, just run the eraser 
round to make a ‘hole’ so that the rose doesn’t have any 
of your background underneath it.

Now there won’t be any green visible through the rose. 
and we can move on.

Step 7: Finishing Touches. 

We’re going to do two last things to our painting before we call it done: Add a bit of 
depth to the image using the Airbrush, and crop  the canvas down so that the rose is 
centered on the image.

Using the Airbrush, we are going to outline the rose with a slight shadow. Se-
lect the Airbrush tool from the Tool Picker and set it to 80% size. Make sure 
Autoflow is ON in the Tool Controls Pane, and set Tilt Angle and Taper Length 
to 0%.

Set the color in the Color Picker to black by dragging the brightness slider down.

With the background Layer still selected, clic the ‘Add Layer’ button. A new layer is 
added above the background and below the first rose Layer. This new Layer is empty.

With the new Layer selected, use the Airbrush to 
draw an outline around the rose. Let the stroke go 
half under the rose, so we’re just seeing a black 
halo. Because ‘Autoflow’ is ON, the Airbrush sprays 
paint even when we’re not moving, so try to draw the 
outline fairly  loosely, don’t worry if it doesn’t look too 
smooth.

You’ll end up with something a bit like this. Terrible, 
isn’t it! Fortunately, we can improve the situation by 
fading the line out slightly using the Opacity control 
for the Layer.



Click the arrow next to the Layer you 
just added paint to. You’ll get the Layer 
Information panel. At the top  of this 
there is an item labelled ‘Opacity’. This 
is used to control how opaque the 
Layer is. By adjusting this control we 
can fade out the contents of a Layer 
without changing the paint directly.

By clicking and dragging in the green bar next to 
Opacity  (where it says ‘100%’) you can change the 
opacity. Every  time you release the mouse, the 
painting will update to show the new setting.

Set the dial to around 20% and click OK. you may 
need to adjust that value depending on how much 
paint you applied with your Airbrush.

The layer is now faded out and you end up  with 
something more subtle like this. The outline is just 
a hint rather than anything solid because we’re 
just trying to give the image a bit more depth.

Finally, the rose is a bit too far to the right so we want to clip a bit off the canvas. To do 
that, go to the Edit Menu and select ‘Resize the Canvas’. This opens up  the Resize 
Panel.

The Resize Panel is used to change the size 
of the canvas without changing the size of its 
contents. So when we’re done, the Rose will 
be the same size it was, but we will have 
clipped away some of the empty space to the 
left of it.

Because we want to change the shape of the 
canvas (we want to make it a square, not a 
longer rectangle) we have to make sure the 
‘Keep the original painting aspect’ check box 
is not ticked. If that’s ticked, any change we 
make to the width will also change the 

height, and we don’t want that. Then, enter 852 in the Width pixels box. Press Tab to let 
the panel know you want that to be the new number and you’ll see the preview at the 
bottom of the panel change in size.



Unfortunately, our clipping of the canvas looks to have cut off part 
of the rose! Don’t worry, nothing is fixed yet and we can adjust that 
here before we apply.

Just click and drag in that little preview and you can move the con-
tents around. Drag the rose to the left so that it’s fully  visible on 
the new canvas.

The mini-preview shows us what our painting is going to look like 
when we press OK. Dragging the contents around in there just 
tells ArtRage which parts of the painting you want to keep  when 
you slice off the edges.

Press OK to accept the changes and ArtRage will clip the canvas.

As a final thought, if you don’t like the look of the pencil lines on top  of your paint, you 
can just go to the Layer Palette and click the eye icon next to the pencils Layer. That will 
turn the Layer off, making it invisible without deleting its contents. You can always turn it 
on again later if you prefer.

Step 8: Finished! 

Congratulations, you’ve just produced a 
painting in ArtRage!

If you want to send it to your friends, 
there’s one more thing that you need to 
know about how ArtRage works.

ArtRage painting files (created when 
you use ‘Save Painting..’ in the File 
menu) contain lots of information spe-
cific to ArtRage. Features such as the 
lumpiness and wetness of paint aren’t 
stored in other formats, and applications 
that display images such as JPEG won’t 
necessarily understand those features. 
This means that if you want to send an 
ArtRage Painting to a friend, the best 
bet is to Export it in a different format.



In the File menu you will find ‘Export As Image...’. This option allows you to save a copy 
of your painting as a normal image file. When you Export a painting, your original paint-
ing remains intact and you can still open it again at any time and access the Layers, the 
smearing paint etc. but a second copy is saved in a ‘flat’ format that can be understood 
by other image applications.

When you select ‘Export As Image...’, you will be prompted to choose a file name and a 
file format. The file formats available vary depending on which Operating System you 
are using, but they contain standard formats such as JPEG, BMP, PSD, and PNG that 
are understood by other applications. To create a small image, save as JPEG. To create 
a higher quality image, save as PNG.

Please never use Export to save your work in progress, always make sure you save a 
Painting file for your project using ‘Save Painting’ in the File menu. Export should only 
be used when you want to create a copy to share with someone.

Thanks For Painting!

This Quick Start guide has given a basic overview of some of the features in ArtRage, 
and how the product works. There are many more features to explore, such as Metallic 
Paint, Glitter, Stencils, and Reference images. ArtRage is all about playing with paint 
and working naturally, so don’t be afraid to get in there and try stuff out to see what 
happens. If it doesn’t end up looking good, there’s always Undo, and at least you 
haven’t just ruined an expensive canvas!

Enjoy painting, and thanks for using ArtRage!


